Keysight M8192A

Synchronization module for M8190A

User’s Guide

KEYSIGHT

TECHNOLOGIES



NOTICE: This document contains references to Agilent
Technologies. Agilent’s former Test and Measurement
business has become Keysight Technologies. For more
information, go to www.keysight.com.

KEYSIGHT

TECHNOLOGIES




Notices
© Keysight Technologies, Inc. 2014

No part of this manual may be
reproduced in any form or by any
means (including electronic storage
and retrieval or translation into a
foreign language) without prior
agreement and written consent from
Keysight Technologies, Inc. as
governed by United States and
international copyright laws.

Manual Part Number
M8192-91020

Edition
Fourth edition, November 2014

Keysight Technologies,
Deutschland GmbH
Herrenberger Str. 130
71034 Boblingen, Germany

For Assistance and Support
http://www.keysight.com/find/assist

Limitation of Warranty

The foregoing warranty shall not
apply to defects resulting from
improper or inadequate maintenance
by Buyer, Buyer-supplied software or
interfacing, unauthorized modification
or misuse, operation outside of the
environmental specifications for the
product, or improper site preparation
or maintenance. No other warranty is
expressed or implied. Keysight
Technologies specifically disclaims
the implied warranties of
Merchantability and Fitness for a
Particular Purpose.

ESD sensitive device

All front-panel connectors of the
M8190A are sensitive to Electrostatic
discharge (ESD). We recommend to
operate the instrument in an
electrostatic safe environment.

There is a risk of instrument
malfunction when touching a
connector.

Please follow this instruction:

Before touching the front-panel
connectors, discharge yourself by
touching the properly grounded
mainframe.

Warranty

THE MATERIAL CONTAINED IN THIS
DOCUMENT IS PROVIDED “AS IS,”
AND IS SUBJECT TO BEING
CHANGED, WITHOUT NOTICE, IN
FUTURE EDITIONS. FURTHER, TO
THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, KEYSIGHT
DISCLAIMS ALL WARRANTIES,
EITHER EXPRESS OR IMPLIED, WITH
REGARD TO THIS MANUAL AND ANY
INFORMATION CONTAINED HEREIN,
INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.
KEYSIGHT SHALL NOT BE LIABLE
FOR ERRORS OR FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE
FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT
OR OF ANY INFORMATION
CONTAINED HEREIN. SHOULD
KEYSIGHT AND THE USER HAVE A
SEPARATE WRITTEN AGREEMENT
WITH WARRANTY TERMS COVERING
THE MATERIAL IN THIS DOCUMENT
THAT CONFLICT WITH THESE
TERMS, THE WARRANTY TERMS IN
THE SEPARATE AGREEMENT SHALL
CONTROL.

Technology Licenses

The hardware and/or software
described in this document are
furnished under a license and may be
used or copied only in accordance
with the terms of such license.

Restricted Rights Legend

If software is for use in the
performance of a U.S. Government
prime contract or subcontract,

Software is delivered and licensed as
“Commercial computer software” as
defined in DFAR 252.227-7014 (June
1995), or as a “commercial item” as
defined in FAR 2.101(a) or as
“Restricted computer software” as
defined in FAR 52.227-19 (June 1987)
or any equivalent agency regulation
or contract clause. Use, duplication or
disclosure of Software is subject to
Keysight Technologies’ standard
commercial license terms, and non-
DOD Departments and Agencies of
the U.S. Government will receive no
greater than Restricted Rights as
defined in FAR 52.227-19(c)(1-2)
(June 1987). U.S. Government users
will receive no greater than Limited
Rights as defined in FAR 52.227-14
(June 1987) or DFAR 252.227-7015
(b)(2) (November 1995), as applicable
in any technical data.

Safety Notices

A CAUTION notice denotes a
hazard. It calls attention to an
operating procedure, practice,
or the like that, if not correctly
performed or adhered to, could
result in damage to the product
or loss of important data. Do not
proceed beyond a CAUTION
notice until the indicated
conditions are fully understood
and met.

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice,
or the like that, if not correctly
performed or adhered to, could
result in personal injury or
death. Do not proceed beyond a
WARNING notice until the
indicated conditions are fully
understood and met.
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Safety Summary

General Safety
Precautions

Initial Inspection

General

Environment
Conditions

Before Applying Power

Line Power
Requirements

Do Not Operate in an
Explosive Atmosphere

Do Not Remove the
Instrument Cover

The following general safety precautions must be observed during all phases of
operation of this instrument. Failure to comply with these precautions or with
specific warnings elsewhere in this manual violates safety standards of design,
manufacture, and intended use of the instrument. For safe operation the general
safety precautions for the M9502A and M9505A AXle chassis, must be followed.
See: http://www.keysight.com/find/M9505A Keysight Technologies Inc. assumes
no liability for the customer's failure to comply with these requirements. Before
operation, review the instrument and manual for safety markings and instructions.
You must follow these to ensure safe operation and to maintain the instrument in
safe condition.

Inspect the shipping container for damage. If there is damage to the container or
cushioning, keep them until you have checked the contents of the shipment for
completeness and verified the instrument both mechanically and electrically. The
Performance Tests give procedures for checking the operation of the instrument. If
the contents are incomplete, mechanical damage or defect is apparent, or if an
instrument does not pass the operator’s checks, notify the nearest Keysight
Technologies Sales/Service Office.

WARNING To avoid hazardous electrical shock, do not perform electrical tests
when there are signs of shipping damage to any portion of the outer enclosure
(covers, panels, etc.).

This product is a Safety Class 3 instrument. The protective features of this product
may be impaired if it is used in a manner not specified in the operation
instructions.

This instrument is intended for indoor use in an installation category II, pollution
degree 2 environment. It is designed to operate within a temperature range of O
°C - 40 °C (32 °F - 105 °F) at a maximum relative humidity of 80% and at altitudes
of up to 2000 meters.

This module can be stored or shipped at temperatures between -40 °C and +70 °C.
Protect the module from temperature extremes that may cause condensation
within it.

Verify that all safety precautions are taken including those defined for the

mainframe.

The Keysight M8190A operates when installed in an Keysight AXle mainframe.

Do not operate the instrument in the presence of flammable gases or fumes.

Operating personnel must not remove instrument covers. Component replacement
and internal adjustments must be made only by qualified personnel. Instruments
that appear damaged or defective should be made inoperative and secured
against unintended operation until they can be repaired by qualified service
personnel.
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Safety Symbols

Table 1 Safety Symbol

Symbol Description

A\

Indicates warning or caution. If you see this symbol on a product, you must refer to the manuals for
specific Warning or Caution information to avoid personal injury or damage to the product.

C-Tick Conformity Mark of the Australian ACA for EMC compliance.

N10149
ICES/NMB-001
CE Marking to state compliance within the European Community: This product is in conformity with the
relevant European Directives.
ISM GRP 1-A

General Recycling Mark

O

Table 2 Compliance and Environmental Information

Symbol Description

This product complies with the WEEE Directive (2002/96/EC) marketing requirements. The affixed label
indicates that you must not discard this electrical/electronic product in domestic household waste.

Product category: With reference to the equipment types in the WEEE Directive Annexure |, this product
is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more information.
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Introduction

Introduction

This chapter provides an overview of Keysight M8192A module.

The M8192A synchronization module is used together with 2 to 6 M8190A modules
to build a fully synchronous, phase coherent multi-channel generator system with up
to 12 analog channels and 24 marker outputs.

When running in synchronous mode, all of the M8190A modules work with the same
sample clock and start at the same time. One of the M8190A modules is designated
as the “master” module and the remaining 1 to 5 modules as “slave”. The common
sample clock is derived either from the master module’s internal clock synthesizer or
from an external sample clock that is connected to the master module’s sample clock
input.

The skew between any two channels is guaranteed to be within +/- 20 ps (without
system level calibration) independent of the sample rate. Using the fine delay adjust
capability of the M8190A with 50 fs resolution, the skew can be adjust to less than 1
ps between any two channels. Once adjusted, the skew is maintained across loading
new waveforms, changing sample rate and power cycles to better than 2 ps.

A common trigger input is available on the synchronization module to trigger all the
connected M8190A modules simultaneously with deterministic latency. Triggered
waveforms have the same inter-channel skew as continuous waveforms. To achieve
the lowest possible trigger delay uncertainty, the trigger input can be synchronized
externally to the SYNC CLK output.

The M8192A module has its own Soft Front Panel but no extra firmware like the
M8190A which allows you to control the trigger mode, trigger level and common
start/stop of the multi-module setup.

Keysight M8192A User’s Guide



Features and Benefits

Additional Documents

1.1 Document History
First Edition
(October 2013)

Second Edition
(December 2013)

Third Edition
(April 2014)

Fourth Edition
(November 2014)

Keysight M8192A User’s Guide
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M8192A provides following features and benefits:

Synchronization of up to 6 M8190A modules (= 12 channels)

One trigger input can trigger up to 6 M8190A modules with deterministic
latency

Skew repeatability of 2 ps between any two channels - independent of
sample rate

Skew resolution of 50 fs between any two channels
1U AXle module for high port density

Additional documentation can be found at:

http://www.Keysight.com/find/M9505A for 5-slot chassis related
documentation.

http://www.Keysight.com/find/M9502A for 2-slot chassis related
documentation.

http://www.Keysight.com/find/M3045A for PCle laptop adapter card
related documentation.

http://www.Keysight.com/find/M9047A for PCle desktop adapter card
related documentation.

http://www.Keysight.com/find/M9536A for embedded AXle controller
related documentation.

http://www.Keysight.com/find/M8190A for AXle based AWG module
related documentation.

The first edition of the user guide describes the functionality of firmware version 3.0.

The second edition of the user guide describes the functionality of firmware version

3.0.

The third edition of the user guide describes the functionality of firmware version 3.2.

The fourth edition of the user guide describes the functionality of firmware version

5.0.


http://www.agilent.com/find/M9505A
http://www.agilent.com/find/M9502A
http://www.agilent.com/find/M9045A
http://www.agilent.com/find/M9047A
http://www.agilent.com/find/M9536A
http://www.agilent.com/find/M8190A
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1.2 Accessories

The M8192A is delivered with three clock cables and two trigger cables to build a 4-
channel synchronous system using two M8190A. In order to synchronize more than
two M8190A, additional clock and trigger cables must be ordered, as listed in the
following table.

Table 3 Accessories for M8091A synchronization
Number of M8190A in the Synchronous Additional M8192A-801 Additional M8192A-802 Trigger Cables
System Clock Cables Needed Needed
2 None None
3 1 1
4 2 2
5 3 3
6 4 4

1.3 M8192A Front Panel

The following figure shows the front panel of the M8192A module:

Figure 1 Front Panel of M8192A

Inputs/Outputs The inputs and outputs available on the front panel of the M8192A module are
described in the Table 4.

14 Keysight M8192A User’s Guide
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Table 4 Inputs and Outputs available on the front panel of the M8192A module
Input/Outputs Description Connector Type
SYS CLK IN Connect to SYS CLK OUT of the M8190A master module Proprietary multi-coax
SYS CLK OUT Connect to SYS CLK IN of M8190A master module and M8190A Proprietary multi-coax
slave module
SYNC CLK OUT Optional: Connect to external DUT SMA
TRIGGER IN Optional: Connect Trigger signal from external DUT for SMA
synchronous external triggering across all M8190A modules
TRIGGER OUT Connect to TRIGGER IN of M8190A master module and M8190A QMA
slave module
Status LED Two LEDs are available at the front panel to indicate the status of the M8192A
module:

The green “Access’LED indicates that the controlling PC exchanges data with the
M8192A module.

The red “Fail’LED has following functionality:
e [tis “ON” for about 30 seconds after powering the AXle chassis.

e After about 30 seconds the LED is switched “OFF”. If an external PC is used
to control the AXle chassis, this PC can be powered after this LED has
switched OFF.

e During normal operation of the module this LED is “OFF”. In case of an error
condition such as e.g. a self-test error, the LED is switch “ON”.

In case the output relay has shut-off because of an external overload condition, this
LED flashes.

Keysight M8192A User’s Guide 15
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18 M8192A Installation

2.1 Introduction

This chapter explains the steps required to install M8192A module.

2.1.1 Pre-Requisites

The following are the pre-requisites for installing Keysight M8192A software:
e The supported operating systems are:
—  Windows Vista (32 bit)
- Windows Vista (64 bit)
-  Windows 7 (32 bit)
—  Windows 7 (64 bit)
—  Windows 8

e Ensure that you have Keysight IO Libraries Suite Version 16.3 or higher
installed on your system. The Keysight |O Libraries Suite can be found on
the CD that is part of shipment content or at
http://www.Keysight.com/find/iosuite.

m The Keysight M8192A V3.0 or later does not support Windows® XP® operating
system.

18 Keysight M8192A User’s Guide
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2.1.2 Installation Process
Follow the given steps to install M8192A module on your system:

1. Double-click the executable (M8792_Setup.exe). This executable file will be
available on either CD or Web.

2. The Keysight M8192A Setup will prepare the InstallShield Wizard for the
installation process. The following window will appear.

Agilent M8192 - InstallShield Wizard e @ ==

Preparing Setup
Fleaze wait while the InstalShield ‘Wizard prepares the zetup.

Agilent MB192 Setup iz preparing the InstallShield *Wizard, which will quide vou through the rest
of the setup process. Please wait.

IrstallShield

Cancel

Keysight M8192A User’s Guide 19
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M8192A Installation

Follow the onscreen instructions to begin the installation process. Click
Next.

Agilent M8192 - InstallShield Wizard =

Welcome to the InstallShield
Wizard for Agilent M8192.

The InstallShield Wizard will install Agilent M8192
version 2.4.1028.0 on your computer.

To continue, click Next.

< Back [ Next > ][ Cancel ]

We recommend you to read the document to check if your hardware
configuration is supported.

Click Next to proceed to the license agreements.

Agilent M8192 - InstaliShield Wizard ==
Welcome to the InstallShield )
Wizard for Agilent M8192. ".

The InstallShield Wizard will install Agilent M8192
version 2.4.1028.0 on your computer.

Before you proceed, please read this document
to check if your hardware configuration is
supported.

To continue, click Next.

< Back E Next> [ Cancel

Keysight M8192A User’s Guide
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Accept the terms of Keysight software end-user license agreement. Click
Next.

Agilent MB8192 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

AGILENT SOFTWARE END-USER LICENSE &
AGREEMENT

ATTENTION: THIS SOFTWARE IS SUBJECT TO THE END-USER LICENSE
AGEFEMENT (“EULA™) SET FORTH BELOW.

TO INSTALL OR USE THE SOFTWARE, YOU MUST FIRST AGREE TO THE
EULA BELOW. IF THE EULA IS PRESENTED TO YOU ELECTRONICALLY
AND IF YOU HAVE READ, UNDERSTAND AND AGREE TO BE BOUND BY
THE TERMS OF THE EULA, CLICK “AGREE”. IF THE EULA IS PRESENTED -

@ 1l accept the terms of the license aqresment Pririt

) | do not accept the terms of the license agreement

I < Back J[ Newt » ll Cancel I

Accept the terms of Keysight VI Driver Source Code license agreement.
Click Next.

Agilent MB8192 - InstallShield Wizard

License Agreement
Pleaze read the following license agreement carefully.

Agilent IVI Driver Source Code License Agreement Terms  *

This license applies to the IVI driver Source Code provided with the Agilent
installer and mstalled to the directories containing a copy of this license.

ATTENTION: DOWNLOADING, COPYING, PUBLICLY DISTRIBUTING,
OR USING THIS SOFTWARE IS SUBJECT TO THE AGREEMENT SET
FORTH BELOW.

-
T TLATIAT MALTE OTATIT TATOT AT T AT TITAT TTIT COATTIE AT TmaT

@ il accept the terms of the license agreement it

1 | do not accept the terms of the license agreement

< Back I[ Mest > l[ Cancel I

21
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7.

8.

Select Yes if you want to read the post-installation instructions, once the
installation is finished. Click Next.

Agilent M8192 - InstallShield Wizard (=22
Post-Installation Instructions ", : -~
a®e
-8 -
L)

Do you want to read the post-installation inztructions when finished?

Mo

| < Back |[ Newt » ll Cancel

Select a setup type either Complete or Custom.
Click Next.

Agilent M&192 - InstallShield Wizard (23]

Setup Type
Select the setup type to install

Pleasze select a setup type,

All program features will be installed. [Fequires the most disk space.]

Cugtom
@ Select which program features you want installed. Fecommended for

advanced users.

< Back " Mest » || Cancel

Keysight M8192A User’s Guide
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9. Click Next to begin installation.

23

Agilent M8192 - InstallShield Wizard

Ready to Install the Program
The wizard iz ready to begin installation.

Click Install to begin the installation.

If wou want ta review or change any of pour installation settings. click Back. Click Cancel to exit
the wizard,

InstalShield

[ <Back [ Instal |[ Cancel

10. The Keysight M8192A will configure the new software installation.

Agilent M&192 - InstallShield Wizard
Setup Status

Agilent MB192 is configuring your new software installation.

Inztalling

IstallShield

i Cancel

23
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11.

The following screen will appear once the Keysight M8192A software is
successfully installed on your system. Click Finish to restart your system.

P
>

"M

Agilent ME192 - InstallShield Wizard

InstallShield Wizard Complete T e,

The InstallShield Wizard has successfully installed Agilent
18152, Before you can use the program, you must restart your
cornputer.

@ Mas. | want to restart rmy cormputer o

(0 Moo, | will restart my computer later.

Remove any disks from their dives, and then click Finish to
complete setup.

< Back Cancel

This completes the Keysight M8192A software installation.

Keysight M8192A User’s Guide
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If your instrument is already powered up and connected to your PC using the PCle
cable, just reboot your PC and start with step 5.

Follow the post installation steps as shown below:

1.
2.
3.

Shut down PC and instrument.
Connect instrument to PC using the PCle cable.

Switch on instrument. Wait until the “Access” LED of the M8192A has
switched from red to green.

Switch on PC.
The PC should automatically recognize the instrument.

Check this in the device manager; e.g. via Computer - Manage - Device
Manager:

The instrument should be visible in the device tree as Keysight = M8792.

m Your PC might request a reboot. Reboot your PC, if requested.

Keysight M8192A User’s Guide

Check if the M8192 is also visible in the Keysight Connection Expert:

e.g. via Start Menu =2 Keysight IO Libraries Suite = Keysight Connection
Expert.

If something went wrong and the Instrument is not shown in the PXI
section, it may be necessary to reboot the PC once more.

Install Intel Network Drivers on Windows XP: The AXle chassis contains an
Intel 82573L NIC as a PCle endpoint. Refer to the AXle chassis User’s Guide
at http://www.Keysight.com/find/M9505A for instructions how to install
this driver.

25


http://www.agilent.com/find/M9505A

26 M8192A Installation

2.1.4 How to Control the Instrument

In order to control the instrument:

1. Start the Soft Front Panel (Start > All Programs > Keysight > M8192 >
M8192 Soft Front Panel).

2. Adialog will open, in which you can select your instrument.

3. Add Keysight M8190 instruments to the system and connect them to the
M8192.

4. Use Help > About to get information about available remote connections.

2.2 AXl| Chasis

The detailed documentation for the AXle chassis can be found at:
o hittp://www.Keysight.com/find/M9505A for 5-slot chassis
e http://www.Keysight.com/find/M9502A for 2-slot chassis.

2.2.1 ESM Front Panel Connector

The ESM Front Panel Connector is shown in the figure below:

POe

Agilent '—*v-“ ;v;y % (= - :‘ (”*) - ) © ,*. L‘:Z:O M95054Jo130 &_
s Raiinsaeietd agax cwcx - O
MUL“FWAME INPUT M\A.'IFMME ouTPUT SYATUS

bbb bbb

26 Keysight M8192A User’s Guide
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1 PCle Connects a host PC to the chassis via PCle.
PCle is the only interface that can be used to control the M8192A
module.
Multiframe Input Synchronizes timing signals with multiple daisy-chained chassis.
Multiframe Output These signals are not needed to synchronize M8190A modules. The
M8192A synchronization module is needed instead.
4 Trigger In External Trigger connections.
Trigger Out The Trigger In of the AXle ESM cannot be used to trigger the M8192A.
The M8192A has its own Trigger In.
The Trigger Out of the AXle ESM cannot be controlled by the M8192A.
Clock In ]
External clock connections.
Clock Out
LAN Connects the host PC to the chassis, via 10/100/1000 Ethernet.
In particular, the LAN connector is used for ESM configuration, but
NOT to communicate to the M8192A.
9 Status Light Indicates the chassis status.
Keysight M8192A User’s Guide 27
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Introduction

This chapter describes how to configure a synchronous system. The term
‘synchronous system’ describes multiple M8T190A AWG modules that operate entirely
synchronous with respect to timing parameters including synchronous start,
synchronous sequencing, common trigger and common sample clock. A
synchronous system consists of:

e M8192A synchronization module

e One M8190A AWG master module

e One or up to five M8190A AWG slave modules

e  One or more M9502A 2-slot AXle chassis or M9505A 5-slot AXle chassis
e Anexternal PC to control the synchronous system

e Trigger cables and clock cables to synchronize all modules in the system
e MB8192A software that controls the synchronous operation of the system

Any M8190A module may become a master module or slave module by software
configuration and by connecting external cables accordingly.

The M8192A synchronization module is designed to synchronize up to six M8190A
arbitrary waveform generator modules. The M8190A modules can be located in the
same or different AXle chassis as the M8192A. This allows very flexible configurations
to address a variety of applications.

A synchronous trigger signal to start the system synchronously and a common clock
signal is distributed using special cables. These cables are connected on the front
panel between the M8192A synchronization module and the M8190A arbitrary
waveform generator modules.

All synchronous system configurations require an external desktop PC or laptop PC
with PCle interface cable connection to control the system. In case of multiple AXle
chassis configurations, a desktop PC with two or even three PCle adapters is
required.

Any even and odd number of up to 12 Arbitrary Waveform Generator channels can
be configured using a combination of 1-channel and 2-channel M8190A Arbitrary
Waveform Generators (see section 3.2). Typical multi-channel configurations are
described in the following subchapters:

4 M8190A Arbitrary Waveform Generator Channels

To configure a synchronous system with 4 channels, use one 5-slot AXle chassis, one
M8192A and two M8190A 2-channel Arbitrary Waveform Generator modules.

This configuration can be ordered as a pre-configured M8190S multi-channel AWG
system.
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3.1.2 6 (or 8) M8190A Arbitrary Waveform Generator Channels

To configure a synchronous system with 6 (or 8) channels, use two 5-slot AXle
chassis, one M8192A and 3 (or 4) M8190A 2-channel Arbitrary Waveform Generator
modules. This synchronous system can be controlled from one external PC that
supports two PCle adapter cards.

This 8-channel configuration can be ordered as a pre-configured M8190S multi-
channel AWG system.

3.1.3 10 (or 12) M8190A Arbitrary Waveform Generator Channels

To configure a synchronous system with 10 (or 12) channels, use three 5-slot AXle
chassis, one M8192A and 5 (or 6) M8190A 2-channel Arbitrary Waveform Generator
modules. This synchronous system can be controlled from one external PC that
supports three PCle adapter cards.

3.2 Supported AXle Frame Combinations

Besides the typical and most common synchronous system configurations described
in chapter 3.1 the synchronous system configuration is not limited to these example.
A general configuration of a synchronous system can be configured by a combination
of up to seven M9502A 2-slot AXle chassis and M9505A b-slot AXle chassis.

The trigger and clock cables needed for the synchronous system are limited in
physical length. As a result when using three or more AXle chassis to configure a
synchronous system, the M8192A synchronization module must be inserted in the
middle AXle chassis.

Due to limited physical length of the trigger cables and clock cables, synchronous
systems as listed in the Table 5 can be configured.
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Table 5 Valid Synchronous System Configurations
Number of Number of Supported AXle Chassis Combinations
M8192A M8190A
1 2 Three M9502A 2-slot AXle chassis or

One M9505A 5-slot AXle chassis or
Two M9505A 5-slot AXIe chassis

1 3 Four M9502A 2-slot AXle chassis or
One M9505A 5-slot AXIe chassis plus one M9502A 2-slot AXle chassis or
Two M9505A 5-slot AXIe chassis

1 4 Five M9502A 2-slot AXle chassis or
One M9505A 5-slot AXle chassis plus two M9502A 2-slot AXle chassis or
Two M9505A 5-slot AXIe chassis

1 5 Six M9502A 2-slot AXle chassis or
One M9505A 5-slot AXle chassis plus three M9502A 2-slot AXle chassis or
Two M9505A 5-slot AXle chassis plus one M9502A 2-slot AXle chassis

1 6 Seven M9502A 2-slot AXle chassis or
One M9505A 5-slot AXle chassis plus four M9502A 2-slot AXle chassis or
Two M9505A 5-slot AXle chassis plus two M9502A 2-slot AXle chassis or
Three M9505A 5-slot AXle chassis
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3.3 Controlling One AXle Chassis

The basic configuration of a synchronous system with four synchronous M8190A
AWG channels is shown in Figure 2:

External Host PC M9048 PCle
Adapter

Figure 2 One AXle chassis connected to external host PC

A synchronous system with four synchronous M8190A AWG channels consists of:
e  Two M8190A 2-channel arbitrary waveform generator modules

e MB8192A synchronization module. The delivery content of the M8192A
synchronization module includes:

—  Three clock cables with proprietary multi-coax connectors at each side.
See Figure 3.

—  Two trigger cables with a QMA connector at one end and a SMA
connector at the other end. See Figure 4.

¢ MO950bA AXle chassis
e  External controlling PC including PCle IF card and PCle cable

Figure 3~ M8192A-801 proprietary multi-coax clock cable
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Figure 4 M8192A-802 QMA to SMA trigger cable
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3.4 Controlling Multiple AXle Chassis

A synchronous system that consists of multiple (more than one) AXle chassis can be
controlled in the following two ways:

e One PC controls multiple chassis
e Multiple PCs control multiple chassis

3.4.1 One PC Controls Multiple Chassis

If you are using multiple AXle chassis (any combination of the Keysight M9502A 2-
Slot or M9505A 5-Slot chassis) connected to your PC, Keysight Connection Expert
finds both the chassis at the same local IP address
(TCPIPQ::169.254.1.0::5052:SOCKET). Refer to Figure 5.

M9048 PCle
Adapters

External Host PC

» , FETTE oo

L RIIIXITFFEFT =
.,,==szxxxzz= -

Figure 5 Multiple AXle chassis connected to external host PC

Keysight Connection Expert finds both chassis but since the IP addresses are the
same, it is impaossible to use the Chassis Web Interface, Soft Front Panel, or specify a
chassis for programming.

If you have two or more AXle chassis, the solution is to connect them to an optional
switch or hub as shown in  Figure 6.

In this scenario, the Host PC must connect to the same network hub or switch as the
AXle chassis.
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External Host PC

36

M9048 PCle
Adapters

Optional: LAN Switch

B | —=

Figure 6 Using a LAN switch for multiple AXle chassis

Although it is not required, manually assigned a unique, static IP address in the
optional switch, will speed up network resolution at Windows startup and eliminate
any potential network resolution issues.
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3.4.2 Multiple PC Controls Multiple Chassis

The configuration where multiple PC are used to control multiple AXle chassis may
be used to increase the data throughput over each PCle link from the host PC to the
AXle chassis. Streaming applications that require multiple synchronous AWG
channels can exploit this type of configuration to increase the streaming throughput
to each AWG channel.

If you have multiple PCs that are connected to multiple AXle chassis, each PC
controls one AXle chassis over PCle using an M9048A PCle IF card.

The “Master” PC that controls the M8192A over PCle, controls the “Slave” PCs using
the LAN IF card.

External Host PC 9048 PCle

Adapter

Adapter

External Host PC M9048 PCle

% Adapter

External HostPC 149048 PCle

‘ %i Adapter

Fi
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External Host PC WS048 PCle AXle Chassis with M8190A

AXle Chassis with 181904

%~ TTEET
==

SR IFTEFFTETL =

Optional: LAN Switch

ey TS
LEIIBTETEETZ

gure 7 Multiple PCs controls multiple AXle chassis
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3.5 Synchronous System Cabling

This section describes the cable connections of an eight channel synchronous
system. An eight channel synchronous system consists of:

e  Four M8190A 2-channel arbitrary waveform generator modules

e MB8192A synchronization module. The delivery content of the M8192A
synchronization module includes:

—  Five clock cables with proprietary multi-coax connectors at each side.

—  Four trigger cables with a QMA connector at one end and a SMA
connector at the other end.

e Two M9505A AXle chassis
e External controlling PC including PCle IF card and PCle cable

Figure 8 depicts the eight channel synchronous system cabling.

TS

3048 PCle
Adapters

EAZE

External Host PC

..
2 ¢

e —— /T

External Trigger
from DUT

Figure 8  System level cabling of an eight channel synchronous system

The highlighted cables in the synchronous system cabling are described in

Table 6.
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Table 6 Cable Connections

Cable Cable Type Source DESEW)]

No.

1 Proprietary multi-coax Master module: SYS CLK OUT Sync module: SYS CLK IN

2 Proprietary multi-coax Sync module: SYS CLK OUT Master module: SYS CLK IN

3-5 Proprietary multi-coax Sync module: SYS CLK OUT Up to 5 slave modules:
SYSCLKIN

6 SMA to SMA Sync module: SYNC CLK OUT Device Under Test (DUT)

7 SMA to SMA Device Under Test (DUT) Sync module: Trigger IN

8 QMA to SMA Sync module: TRIGGER OUT Master module: Trigger IN

9-11 QMA to SMA Sync module: TRIGGER OUT Up to 5 slave modules: Trigger IN

3.6 Controlling the Synchronous System

This section describes the ways to control the synchronous system.

3.6.1 Requirements for Controlling the Synchronous System

The requirements for controlling the synchronous system are as follows:

e Anyremotely controlled M8190A module that will become part of the
synchronous system must be made visible in ACE (Keysight Connection
Expert)

e The M8190A firmware of each module of the synchronous system must be
started prior to configuring the synchronous system.

e  SYS CLK outputs of the M8192A must be used in ascending order without
leaving a gap. Example: For four M8190A, SYSCLK OUT 1, SYSCLK OUT 2,
SYSCLK OUT 3 and SYSCLK OUT 4 must be connected.

3.6.2 Synchronous System Operation Modes

The synchronous system has the following two modes of operation:
1. Configuration mode
2. Operation mode
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3.6.2.1 Configuration Mode

The configuration mode is used while connecting external cables of the synchronous
system or during configuration of main parameters such as setting the common
sample clock frequency that affects the entire synchronous system. Specifically when
defining which M8190A found by Keysight Connection Expert (ACE) modules belong
to the synchronous system or to determine which M8190A is the master module or a
slave module or when system parameters (see section_3.6.3.2) are being changed,
the system must be stopped and set in configuration mode:

3.6.2.2 Operation Mode

The operation mode is used for data generation and to synchronously start the
system. To start data generation you must switch to operation mode.

Whenever the user switches from configuration mode to operation mode, following
system checks and actions are performed:

e \Verify that the firmware version of all M8190A AWG modules and the
M8192A synchronization module of the synchronous system is identical and
higher than V3.0.0

e Verify that each M8190A of the synchronous system has a common set of
options. E.g. all M8190A of the synchronous system must operate in the
same bit mode. |.e. when operating the synchronous system in 14 bit mode,
option -14B must be installed on each M8190A of the synchronous system.
When operating the synchronous system in interpolation mode, option -
DUC must be installed on each M8190A of the synchronous system.

e Each M8190A in the synchronous system measures the frequency of the
sample clock and synchronization clock. As a result, correct cabling of the
clock cables is verified.

e \Verify that a trigger propagates from the M8192A synchronization module
to each M8190A of the synchronous system. As a result, correct cabling of
the trigger cables is verified

e Transfer the settings of sample frequency, bit mode (including interpolation
factor) to the slave modules.

e  Setarm mode of all the modules in the synchronous system to “Armed”.

e  Settrigger mode of all the modules in the synchronous system to
“Triggered”.

e  Perform accurate delay alignment among all M8190A channel in the
synchronous system.
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3.6.3 Control Parameters

In a synchronous system, many parameters such as the common sample clock
frequency cannot be adjusted individually on each M8190A AWG module. Otherwise,
synchronous operation would not be possible. This section describes how to control
parameters that affect the entire synchronous system. This section describes as well
if a specific system parameter is modified by the M8192A or the M8190A.

3.6.3.1 Using M8192A Soft Front Panel

The Soft Front Panel of the M8192A lists all M8190A that are available in the local PC
or in ACE in a table. Using this table the user can define that a certain M8190A will
be,

e  Part of the synchronous system (or will not be part)
e The master module
e The slave module
Following parameters can be controlled using the M8192A Soft Front Panel:
e Trigger threshold
e Trigger input impedance
e Trigger input enable

e  Synchronous start and stop of all M8190A modules in the system by
software

3.6.3.2 Using M8190A Soft Front Panel

The following parameters that affect the entire synchronous system can be
controlled from the M8T190A master module.

e Sample Clock Frequency

e  Sample Clock Source ( Internal or External)

e Reference Clock Source (Backplane, Reference CLK In, Internal)

e  Output Mode (14bit or 12 bit or interpolation mode and interpolation factor)

Above parameters are disabled in the M8190A slave modules. To modify above
parameter you need to switch to configuration mode first.

Table 7 lists the common synchronous system parameters that can be
controlled by the M8192A or M8190A.
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Table 7 Parameters controlled from M8192A and M8190A
Functionality M8192A Synchronization Module M8190A Master Module M8190A Slave Module
Sample frequency Not available Controls all M8190A. Modificationis ~ Disabled
only possible in configuration mode
Output Mode :14 bit or 12 bit Not available Controls all M8190A. Modificationis ~ Disabled

or interpolation mode
(INTx3, INTX12, INTx24 or
INTx48)

only possible in configuration mode

Coupling between channels All M8190A always operate in

coupled mode

Coupled mode is always turned on by
the M8192A and uncoupled mode is
disabled

Coupled mode is always turned on
by the M8192A and uncoupled
mode is disabled

Arm mode All M8190A must operate in arm Arm mode ‘armed’ is disabled Arm mode ‘armed’ is disabled
mode ‘self (arm mode ‘armed’ is
not supported)

Trigger mode All M8190A must operate in Continuous, gated is not selectable Continuous, gated is not selectable
triggered mode (continuous, gated
is not enabled)

Trigger Threshold Affects all M8190A Disabled Disabled

Trigger Impedance Affects all M8190A Disabled Disabled

Trigger Input Enable/Disable Affects all M8190A Disabled Disabled

42

Force trigger

Affects all M8190A

Locally available for debugging

Locally available for debugging

Force event

Not available

Locally available for debugging

Locally available for debugging

Run/Stop

Enhanced by: Armed, Trigger,
Armed & Trigger, Stop

Disabled

Disabled
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4.1 Introduction

This chapter describes the M8192A Soft Front Panel (SFP).

4.2 Launching the M8192A Soft Front Panel

There are three ways to launch the M8190A Soft Front Panel. They are as following:
1. From the Start Menu, select All Programs = Keysight > M8192 - M8192
Soft Front Panel.

2. From the Keysight Connection Expert, select the discovered M8192 module,
press the right mouse key to open the context menu and select “Send
Commands To This Instrument”.

3. From the Keysight Connection Expert, select the discovered M8192 module,
select the “Installed Software” tab and press the “Start SFP” button.
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The following screen will appear:

Connect to Instrurment @

Select Instrument:

Modules: [¥] Simulation Mode

Alias Slot Model Description
MB192A

Selected Instrument:

M8192A

Simulate | [Close Application

Figure 9 M8192A connected to PC
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The instrument selection dialog shows the addresses of the discovered M8192A
modules. Select a module from the list and press “Connect”.

If no M8192A module is connected to your PC, you can check “Simulation Mode” to
simulate an M8192A module.

Connect to Instrument @
Select Instrument:
Modules: Simulation Mode
Alias Slot Model Description
M8192A
Selected Instrument:
M81924
l Simulate l [Close Application
Figure 10

M8192A connected in simulation mode

4.3 MB8192A Soft Front Panel

The M8192A Soft Front Panel allows you to:
e Configure a multi-module group,
[ )

Control the M8192 trigger input parameters,

Synchronously start all channels of the multi-module group.
It includes the following GUI items:

e Title Bar

e Menu Bar

e  Status Bar

e Tabs (Module, Sync)

The detailed information on these GUI items is described in the sections that follow
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4.3.1 Title Bar

4.3.2 Menu Bar

4.3.2.1 File
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The title bar contains the standard Microsoft Windows elements such as the window
title and the icons for minimizing, maximizing, or closing the window.

The menu bar consists of various pull down menus that provide access to the
different functions and launch interactive GUI tools.

The menu bar includes the following pull down menu:

File
View
Utilities
Tools
Help

Each pull down menu and its options are described in the following sections.

The File menu includes the following selections:

File > Connect...

Opens the instrument selection dialog.

File = Save Configuration As...

Saves configuration as a text file.

File = Load Configuration...

Load the previously saved configuration file.
File = Exit

Exits the soft front panel.
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4.3.2.2 View

The View menu includes the following selections:
e View -> Refresh
Reads the instrument state and updates all fields.

4.3.2.3 Utilities

The Utility menu includes the following selections:
e  Utility > Reset
Resets the instrument, reads the state and updates all fields.
e  Utility = Errors...
Opens the “Errors” window to display the errors reported by the instrument.
e  Utility > Self Test...

Opens the “Self Test” window to start the self-test and display the result
after completion.

4.3.2.4 Tools

The Tools menu includes the following selections:
e Tools > Monitor Driver Calls
Opens the “Driver Call Log” window.
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4.3.2.5 Help

The Help menu includes the following selections:
e Help - Driver Help
Opens the VI driver online help.
e Help = Online Support
Opens the instrument’s product support web page.
e Help = About

Displays revision information for hardware, software and firmware. Displays
the serial number of the connected module.

4.3.3 Status Bar

The Status Bar contains the following two fields from left to right:
e Connection Status

—  “Not Connected” - No instrument is connected.

—  “Connected: <Instrument resource string>” — An instrument is
connected. The resource string, for example PX136::0::0::INSTR is
displayed.

—  “Simulation Mode” - No real instrument is connected. The user
interface is in simulation mode.

Click this field to open the “Connect to Instrument” dialog.
e  Error status
—  “Error” - The connected instrument reported an error.
—  “No Error” - No errors occurred.
Click this field to open the “Error” window.

4.3.4 Tabs (Module/Sync Tabs)

These tabs are used to configure the most important parameters of the M8192A
module. They are described in detail in the sections that follow.

4.3.5 Numeric Control Usage

The numeric control is used to adjust the value and units. Whenever you bring the
mouse pointer over the numeric control, a tooltip appears which shows the possible
values in that range.
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Frequency:
2.5 CuH- |lA
= * N Minimum = 1.00e4000 MHz and Maximum = 6.00e+000 GHz |
-
Tooltip

Figure 11 Tooltip showing possible values in the range

The numeric controls can be used in the following ways:

e Use the up/down arrows to change the value. The control automatically
stops at the maximum/minimum allowed value.

e You can increase or decrease the value starting at a specific portion of the
value. To do this, place the cursor to the right of the targeted digit and use
the up/down arrows. This is especially useful when changing a signal
characteristic that is immediately implemented, and observing the result in
another instrument. For example, you can change the signal generator’s
frequency by increments of 10 MHz and observe the measured result in a
signal analyzer:

Frequency:

j2.9715 GHz |&5

Figure 12 Typing directly into the field

e Type directly into the field and press the Enter key. If you enter a value
outside the allowed range, the control automatically limits the entered
value to the maximum or minimum allowed value.

e When you type the value, you can type the first letter of the allowed unit of
measure to set the units. For example, in the Frequency control you can use
"H", "K", "M", or "G" to specify hertz, kilohertz, megahertz, or gigahertz,
respectively. (The control is not case sensitive.)
The controls allow scientific notation if it is appropriate to the allowed range. Type
the first decimal number, enter an "E", and omit any trailing zeroes. For example, in
the Frequency control you can type 2.5e+9 and press Enter to set the frequency to
2.5 GHz. (The plus sign is automatically inserted if it is omitted.)
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4.4 Driver Call Log Window

Use this window to inspect the sequence of SCPI commands used to configure the

M8192A module.

M8192A Soft Front Panel

Drriver Call Log

Call History:

ARMTRIGILEY 0.5
ARMTRIGIMP LOW
TRIG:BEG:HWD ON

(]

[ Save As.. | [Clear History

[ Close

-

Figure 13

Driver Call Log Window

It has the following buttons:

Keysight M8192A User’s Guide

Save...

Saves the Driver Call Log as a text file.

Clear History

Clears the Driver Call Log.
Close

Exits the window.
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4.5 Errors Window

52

Use this window to read out and display the error queue of the M8192A module.

Errors

Error Historny:

==

-

Get Instrument Errﬂr5| [Qlear History

Close

Figure 14 Driver Call Log Window

It has the following buttons:
e  GetInstrument Errors

Queries the instruments error queue and displays the errors, if any.

e  Clear History

Clears the error history.
e Close

Exits the window.
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4.6 Module Tab

The module panel allows you to discover available M8190A modules and to define a
multi-module group consisting of one master and up to five slave modules. The VISA
resource strings for available M8190A modules are displayed in a list under column
“VISA Resource”. The drop down list under column “Mode” provides options to
specify whether a module will be part of multi-module group or not. Select either
“Master” or “Slave” to add a module to the multi-module group. The option “None”
indicates that the module is not part of the group. The module tab also allows you to
switch between “Configuration” and “Operation” mode using the “Configuration
Mode” check box.

@ Agilent ME192A: Synchronization Module for M81904, DEXXXOOMK = ==
File View Utilities Tools Help

Module | Sync
Select M8190A Modules:

VISA Resource Serial Number Mode Identify Slot # Chassis

TCPIPO:localhost:hislipO=zINSTR.  DECO0000O00 [Master '] []dentifyl 0 <information not available>

TCPIPQ:localhost:hislip8:INSTR  DEQO000003 [Siave '] []dentifyl 0 <information not available>

Configuration Mode

Simulation Mode, Slot 0, S/N DEXXXXXXXX |40. No Error

Figure 15 Module Tab

Keysight M8192A User’s Guide 53




54

54

M8192A Soft Front Panel

It has the following controls:

Discover: Click this button to find the available M8190A modules. The
modules that are found are displayed in the list. The firmware of the
modules to be discovered must be running and the modules must be
entered into the Keysight Connection Expert.

M8190A Module Selection List: It has following columns:

—  VISA Resource: Displays the visa resource string of the M8190A
module.

—  Mode: The combo-box in this column can be used to set the multi-
module mode of the module. Select either “Master” or “Slave” to add a
module to synchronization group. The option “None” is used to indicate
that the module is not part of the synchronization group.

—  Serial Number: Displays the serial number of M8190A module.

—  Slot Number: Displays the slot number in AXle chassis.

—  Chassis: Displays the AXle chassis information.

— Identify: The “Identify” button under this column is used to identify a
module. On clicking this button the access LED of the M8190A module
will be flashed for 10 seconds. This allows easy identification of module
in a setup consisting of multiple AXI frames and multiple modules.

Configuration Mode: This check box can be used to switch between

“Configuration” and “Operation” mode. The check box is enabled only when

“Master” module is selected as it is not possible to switch to “Operation”

mode if no master is selected. Similarly while in “Operation” mode if signal

generation is started this check box is disabled. You need to stop the signal
generation to switch to “Configuration” mode.

m It is recommended to follow the below order when exiting the application:

Stop the system.

Switch to Configuration Mode.

Exit the M8192 Soft Front Panel.

Exit any M8190 Soft Front Panel if necessary.

Exit the M8190 firmware instances if not required any more.
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4.7 SyncTab
The Sync tab allows you to modify parameters that affect all the modules in the
synchronous system. This tab can be used to:
e Configure the M8192 trigger input
e  Settrigger threshold and impedance
e  Set the multi-module group in arm mode and send software trigger to start
signal generation
e  Stop signal generation and disable arm mode.
In addition, the Sync tab provides the graphical representation of:
e Sys Clk In and Sync Clk Out for master and slave modules
e Trigger In and Trigger Out for master and slave modules.
@ Agilent ME192A: Synchronization Module for M81904, DEXXXOOMK = ==
File View Utilities Tools Help
| Module | Sync |
Sys Clock Trigger
Sync Clk Out Trigger Qut 1
O Trigger Qut 2
——»
@1 _ Threshold:  [500 mv & [Trigger out 3
v Trigger In &
& @ O O—0 Trigger Out 4
Sys ClkIn o O3 : i
o = Impedance: |Low (50 Q) 'l Trigger Out 5
C 4 ——D
o Trigger Out 6
5 Os —D
O Arm
Arm & Trigger
Simulation Mode, Slot 0, S/N DEXXXXXXXX |40. No Error

Figure 16 Sync Tab
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The Sync Tab provides following controls:

Sys Clk Out: Shows the Sys Clk Out connection to master and slave
modules. While switching to "Operation" mode if there is no cabling issue
and Sys Clk Out connections are valid, the output symbols corresponding to
each module turn "Green". In case of cabling issues, the symbols turn
"Red".

Trigger In On/Off: Use this switch to enable/disable the trigger hardware
input.. When hardware input is disabled, trigger can only be generated
using software trigger (see “Trigger” and “Arm & Trigger” button
descriptions below).

Trigger Out: Shows the Trigger Out connection to master and slave
modules. While switching to "Operation" mode if there is no cabling issue
and Trigger Out connections are valid, the output symbols corresponding to
each module turn "Green". In case of cabling issues, the symbols turn
"Red".

Threshold: Use the numeric control to enter the threshold level of the
M8192A trigger input.

Impedance: Use this dropdown list to set the impedance of the M8192A
trigger input.

Arm: Press this button to set all channels of the multi-module group to an
armed state. Signal generation is started after a trigger is received.

Trigger: Press this button to send software trigger to all channels of the
multi-module group for synchronous start of waveform generation.

Arm & Trigger: Press this button to set all channels of the multi-module
group to an armed state and to send software trigger to all channels for
synchronous start of waveform generation.

Stop: Press this button to stop signal generation and arming mode on all
channels of the multi-module group.
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5.1 Introduction

This chapter describes the SCPI commands that are used to program M8192A

module.

5.2 SCPI Programming

The SCPI programming is supported by the following three LAN protocols:

VXI-11: The Visa Resource String is e.g. “TCPIPO::localhost::inst0::INSTR”.

HiSLIP: this protocol is recommended. It offers the functionality of VXI-11
protocol with better performance that is near socket performance. Visa
Resource Strings look like “TCPIPO::localhost::hislip0::INSTR”. The correct
resource string is shown in the M8192A Soft Front Panel’s “About” dialog
under “ VISA Resource String for...”. To use the HiSlip protocol an I/0
library such as the Keysight I/0 Libraries Suite must be installed. Since the
protocol is new it might not be supported by the installed 1/0 library. The
Keysight 1/0 Libraries Suite 16.1 and above supports it. However, the
Keysight 1/0 Libraries Suite might be installed as secondary 1/0 library. In
this case, check if the primary I/0 library supports HiSLIP. If it does not, the
socket protocol must be used.

Socket: this protocol can be used with any 1/0 library or using standard
operating system socket functionality connecting to port 5025. This
protocol must be used if the used 1/0 library is not supporting HiSLIP
protocol. Visa Resource string looks like
“TCPIPO::localhost::5025::SOCKET”, the exact resource string can be seen
in the M8192A Soft Front Panel’s “About” dialog under “ VISA Resource
String for...”.

m AgM8192 Firmare.exe must be started prior to sending SCPI to the instrument. (See
AgM8192SFP.exe)

5.2.1 AgM8192SFP.exe

The M8192A Software Front Panel and Firmware are one application. You need to
start M8192 Soft Front Panel (AgM8192SFP.exe) before sending SCPI commands to
the instrument. This can be done in the Windows Start menu (Keysight > M8192 >
M8192 Soft Front Panel). You can open the “About” dialog from the M8192A Soft
Front Panel to see the VISA Resource String for the different connection types.

58
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5.2.1.1 Command Line Arguments

(See Communication for details about /s, /t, /i, /AutolD, /NoAutolD, /FallBack).

Table 8 Command Line Arguments

Option DL

/Socket socketPort

Set the socket port at which the firmware waits for SCPI commands

/Telnet telnetPort

Set the telnet port at which the firmware waits for SCPI commands

/Inst instrumentNumber

Set the instrument number (instN, hislipN) at which the firmware waits for SCPI commands

/AutolD Automatically select ports and number for the connections (default behavior).
/NoAutolD Disable the default behavior; i.e. do not automatically select ports and number for the connections.
/FallBack Try to find unused ports and number if starting a server fails.

/r resourceName

Visa PXI resource string of the module to connect to, e.g. PXI12::0::0::INSTR. If this is the last parameter on the
command line, the “/r” can be omitted.

/Master masterModule

Set the M8190 clock master module (LAN VISA resource string, i.e. SOCKET, INST, or HiSLIP).

/Slave slaveModule

Add an M8190 clock slave module (LAN VISA resource string, i.e. SOCKET, INST, or HiSLIP)

5.2.1.2 Communication

Keysight M8192A User’s Guide

Depending on the command line arguments /s, /t, /i, /AutolD, /NoAutolD, /FallBack,
the firmware starts several servers to handle SCPI commands. (Refer to the table
above.)
/Socket, /Telnet, /Inst: If -1, don’t start the respective servers
e Defaults:
—  Socket port: 5025 (e.g. TCPIPO::localhost::5025::SOCKET)
—  Telnet port: 5024

—  HiSLIP, VXI-11.3: 0 (e.g. TCPIPQ::localhost::hislip0::INSTR,
TCPIPO::localhost::inst0::INSTR)
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/FallBack : If starting a server fails because of a conflict, try using another port or

number

HiSLIP, VXI-11.3: increase the index until a server can be started
successfully

Socket, Telnet: start with the port 60000, then increase it until the servers
can be started successfully. If neither socket nor telnet is disabled the
firmware tries to start the servers on two consecutive ports

(socket port = telnet port + 1)

/AutolD : Automatically select ports and number for the connections, which are
unique per instrument.

This is the default behavior; it is not necessary to specify this argument on
the command line.

If only one AXle module is connected to this PC and it is an M8192 module,
first try to use the command line arguments /Socket, /Telnet, /Inst or their
respective default values if they are not specified. If starting the servers
fails, proceed with the steps below.

/Socket, /Telnet, /Inst are ignored (unless they are -1 and a server is
disabled)

If the firmware detects more than one AXle module, use a special
mechanism to obtain a number for the HiSLIP and VXI-11.3 servers, which
makes sure that the firmware uses always the same VISA resource string
per module

The socket and telnet port are then calculated from the HiSLIP index:

—  telnet port = 60000 + 2 * <HIiSLIP index>

—  socket port = 60000 + 2 * <HISLIP index> + 1

/NoAutolD : Do not automatically select ports and number for the connections, use
the values specified with /Socket, /Telnet, /Inst or their respective default values

instead.

If both /NoAutolD and /AutolD are specified, /AutolD overrides /NoAutolD.
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5.3 Programming Recommendations

Keysight M8192A User’s Guide

This section lists some recommendations for programming the instrument.

Start programming from the default setting. The common command for setting the
default setting is:
*RST

The SCPI standard defines a long and a short form of the commands. For fast
programming speed, it is recommended to use the short forms. The short forms of
the commands are represented by upper case letters. For example the short form of
the command to start/begin event to all channels of the multi-module group is:

: TRIG:BEG

To improve programming speed it is also allowed to skip optional subsystem
command parts. Optional subsystem command parts are depicted in square
brackets, e.g. : TRIGger [ :SEQuence] [ : STARt] :BEGin/[ : IMMediate]

If it is important to know whether the last command is completed then send the
common query:
*OPC?

It is recommended to test the new setting which will be programmed on the
instrument by setting it up manually. When you have found the correct setting, then
use this to create the program.

In the program it is recommended to send the command for starting data generation
(: INIT: TMM) as the last command. This way intermediate stop/restarts are avoided

and optimum execution performance is achieved.
*RST # set default settings

# other commands to set modes

# and parameters
:ARM:TRIG:IMP HIGH # settrigger impedance to High
:INIT:IMM # start data generation.
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5.4 System Related Commands (SYSTem Subsystem)

5.4.1

5.4.2

62

:SYSTem:ERRor[:NEXT]?

Command

Long
Parameters
Parameter Suffix
Description

Example

:SYST:ERR?

:SYSTem:ERRor?

None

None

Read and clear one error from the instrument’s error queue.

A record of up to 30 command syntax or hardware errors can be stored in the error
queue. Errors are retrieved in first-in-first-out (FIFO) order. The first error returned is
the first error that was stored. Errors are cleared as you read them.

If more than 30 errors have occurred, the last error stored in the queue (the most
recent error) is replaced with “Queue overflow”. No additional errors are stored until
you remove errors from the queue.

If no errors have occurred when you read the error queue, the instrument responds
with 0,“No error”.

The error queue is cleared by the *cLS command, when the power is cycled, or
when the firmware is re-started.

The error queue is not cleared by a reset (*RST) command.

The error messages have the following format (the error string may contain up to 255
characters):

error number,”Description”, e.g.

-113,”Undefined header”.

Query
:SYST:ERR?

:SYSTem:HELP:HEADers?

Command

Long
Parameters
Parameter Suffix
Description

:SYST:HELP:HEAD?
:SYSTem:HELP:HEADers?
None

None

The HEADers? query returns all SCPI commands and queries and IEEE 488.2
common commands and common queries implemented by the instrument. The
response is a <DEFINITE LENGTH ARBITRARY BLOCK RESPONSE DATA> element.
The full path for every command and query is returned separated by linefeeds. The
syntax of the response is defined as: The <nonzero digit> and sequence of <digit>
follow the rules in IEEE 488.2, Section 8.7.9. An <SCPI header> is defined as: It
contains all the nodes from the root. The <SCPI program mnemonic> contains the
node in standard SCPI format. The short form uses uppercase characters while the
additional characters for the long form are in lowercase characters. Default nodes
are surrounded by square brackets ([]).
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Example Query
:SYST:HELP:HEAD?

5.4.3 :SYSTem:LICense:EXTended:LIST?

Command :SYST:LIC:EXT:LIST?

Long :SYSTem:LICense:EXTended:LIST?
Parameters None

Parameter Suffix None

Description This query lists the licenses installed.
Example Query

:SYST:LIC:EXT:LIST?

5.4.4  :SYSTem:SET[?]

Command :SYST:SET[?]

Long :SYSTem:SET[?]

Parameters <binary block data>

Parameter Suffix None

Description In query form, the command reads a block of data containing the instrument’s

complete set-up. The set-up information includes all parameter and mode settings,
but does not include the contents of the instrument setting memories or the status
group registers. The data is in a binary format, not ASCII, and cannot be edited.

In set form, the block data must be a complete instrument set-up read using the
query form of the command.

This command has the same functionality as the *LRN command.

Example Command
:SYST:SET <binary block data>

Query
:SYST:SET?

b.4.5 :SYSTem:VERSIion?

Command :SYST:VERS?

Long :SYSTem:VERSion?

Parameters None

Parameter Suffix None

Description This query returns a formatted numeric value corresponding to the SCPI version

number for which the instrument complies, for example “1999.0".
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Example

Query
:SYST:VERS?

5.4.6 :SYSTem:COMMunicate:*?

These queries return information about the instrument firmware’s available
connections. If a connection is not available the returned value is -1.

This is only useful if there is more than one Keysight module connected to a PC,
otherwise one would normally use the default connections (HiSLIP and VXI-11
instrument number 0, socket port 5025, telnet port 5024)

One can never be sure if a socket port is already in use, so one could e.g. specify a
HISLIP number on the command line (AgM8192Firmware.exe /AutoID /i 5
/FallBack /r ..)and letthe firmware find an unused socket port. Then this
socket port can be queried using the HiSLIP connection.

5.4.6.1 :SYSTem:COMMunicate:INSTr[:NUMBer]?

Command

Long
Parameters
Parameter Suffix
Description
Example

:SYST:COMM: INST?

:SYSTem:COMMunicate: INSTr?

None

None

This query returns the VXI-11 instrument number used by the firmware.

Query
:SYST:COMM: INST?

5.4.6.2 :SYSTem:COMMunicate:HISLip[:NUMBer]?

Command

Long
Parameters
Parameter Suffix
Description
Example

64

:SYST:COMM:HISL?
:SYSTem:COMMunicate:HISLip?

None

None

This query returns the HiSLIP number used by the firmware.

Query
:SYST:COMM:HISL?
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5.4.6.3 :SYSTem:COMMunicate:SOCKet[:PORT]?

Command

Long
Parameters
Parameter Suffix
Description
Example

:SYST:COMM: SOCK?

:SYSTem:COMMunicate: SOCKet?

None

None

This query returns the socket port used by the firmware.

Query
:SYST:COMM: SOCK?

5.4.6.4 :SYSTem:COMMunicate:TELNet[:PORT]?

Command

Long
Parameters
Parameter Suffix
Description
Example
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:SYST:COMM: TELN?

:SYSTem:COMMunicate: TELNet?

None

None

This query returns the telnet port used by the firmware.

Query
:SYST:COMM: TELN?
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5.5 Common Command List

5.5.1

5.5.2

5.5.3

5.6.4

5.5.6

5.5.6

5.6.7

66

*IDN?

*CLS

*ESE

*ESR?

*OPC

*OPC?

*OPT?

Read the instrument’s identification string, which contains four fields separated by
commas. The first field is the manufacturer’s name, the second field is the model
number, the third field is the serial number, and the fourth field is a revision code
which contains four numbers separated dots and a fifth number separated by a dash:

Keysight Technologies, M8192A,<serial number>, x.x.x.x-h
x.X.x.x= Firmware revision number, e.g. 2.0.0.0
h= Hardware revision number

Clear the event register in all register groups. This command also clears the error
gueue and cancels a *OPC operation. It doesn't clear the enable register.

Enable bits in the Standard Event Status Register to be reported in the Status Byte.
The selected bits are summarized in the “Standard Event” bit (bit 5) of the Status
Byte Register. The *ESE? query returns a value which corresponds to the binary-

weighted sum of all bits enabled decimal by the *ESE command. These bits are not
cleared by a *cLS command. Value Range: 0-255.

Query the Standard Event Status Register. Once a bit is set, it remains set until
cleared by a *cLs (clear status) command or queried by this command. A query of

this register returns a decimal value which corresponds to the binary-weighted sum
of all bits set in the register.

Set the “Operation Complete” bit (bit 0) in the Standard Event register after the
previous commands have been completed.

Return “1” to the output buffer after the previous commands have been completed.
Other commands cannot be executed until this command completes.

Read the installed options. The response consists of any number of fields separated
by commas.

Keysight M8192A User’s Guide



5.5.8

5.59

5.5.10

5.5.11

5.5.12

5.5.13
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*RST

*SRE[?]

*STB?

*TST?

*LRN?

*WAI
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Reset instrument to its factory default state.

Enable bits in the Status Byte to generate a Service Request. To enable specific bits,
you must write a decimal value which corresponds to the binary-weighted sum of the
bits in the register. The selected bits are summarized in the “Master Summary” bit
(bit 6) of the Status Byte Register. If any of the selected bits change from “0” to “1”, a
Service Request signal is generated. The *SRE? query returns a decimal value which

corresponds to the binary-weighted sum of all bits enabled by the *SRE command.

Query the summary (status byte condition) register in this register group. This
command is similar to a Serial Poll but it is processed like any other instrument
command. This command returns the same result as a Serial Poll but the “Master
Summary” bit (bit 6) is not cleared by the *sTB? command.

Execute Self Tests. If self-tests pass, a O is returned. A number lager than O indicates
the number of failed tests.
To get actual messages, use : TEST: TST?

Query the instrument and return a binary block of data containing the current
settings (learn string). You can then send the string back to the instrument to restore
this state at a later time. For proper operation, do not modify the returned string
before sending it to the instrument. Use :SYST:SET to send the learn string. See

section 5.4.4.

Prevents the instrument from executing any further commands until the current
command has finished executing.
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5.6 Status Model

68

Introduction

This section describes the structure of the SCPI status system used by the M8192A.
The status system records various conditions and states of the instrument in several
register groups as shown on the following pages. Each of the register groups is made
up of several low level registers called Condition registers, Event registers, and
Enable registers which control the action of specific bits within the register group.

These groups are explained below:

A condition register continuously monitors the state of the instrument. The
bits in the condition register are updated in real time and the bits are not
latched or buffered. This is a read-only register and bits are not cleared
when you read the register. A query of a condition register returns a
decimal value which corresponds to the binary-weighted sum of all bits set
in that register.

An event register latches the various events from changes in the condition
register. There is no buffering in this register; while an event bit is set,
subsequent events corresponding to that bit are ignored. This is a read only
register. Once a bit is set, it remains set until cleared by query command
(such as STAT: QUES: EVEN?) or a *CLS (clear status) command. A query
of this register returns a decimal value which corresponds to the binary-
weighted sum of all bits set in that register.

An enable register defines which bits in the event register will be reported
to the Status Byte register group. You can write to or read from an enable
register. A *CLS (clear status) command will not clear the enable register
but it does clear all bits in the event register. A STAT: PRES command

clears all bits in the enable register. To enable bits in the enable register to
be reported to the Status Byte register, you must write a decimal value
which corresponds to the binary weighted sum of the corresponding bits.

Transition Filters are used to detect changes of the state in the condition
register and set the corresponding bit in the event register. You can set
transition filter bits to detect positive transitions (PTR), negative transitions
(NTR) or both. Transition filters are read/write registers. They are not
affected by *cLs.
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Figure 17 Status Register Structure
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5.6.1 :STATus:PRESet

Clears all status group event registers. Presets the status group enables PTR and
NTR registers as follows:

ENABLle = 0x0000, PTR = Oxffff, NTR = 0x0000

5.6.2  Status Byte Register

The Status Byte summary register reports conditions from the other status registers.
Data that is waiting in the instrument’s output buffer is immediately reported on the
“Message Available” bit (bit 4) for example. Clearing an event register from one of the
other register groups will clear the corresponding bits in the Status Byte condition
register. Reading all messages from the output buffer, including any pending queries,
will clear the “Message Available” bit. To set the enable register mask and generate
an SRQ (service request), you must write a decimal value to the register using the
*SRE command.

Table 9 Status Byte Register

Bit Number Decimal Value Definition

0 Not used 1 Not Used. Returns “0”

1 Not used 2 Not Used. Returns “0”

2 Error Queue 4 One or more error are stored in the Error Queue

3 Questionable Data 8 One or more bits are set in the Questionable Data Register (bits must be
enabled)

4 Message Available 16 Data is available in the instrument’s output buffer

5 Standard Event 32 One or more bits are set in the Standard Event Register

6 Master Summary 64 One or more bits are set in the Status Byte Register

7 Operational Data 128 One or more bits set in the Operation Data Register (bits must be enabled)
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Questionable Data Register Command Subsystem

The Questionable Data register group provides information about the quality or
integrity of the instrument. Any or all of these conditions can be reported to the
Questionable Data summary bit through the enable register.

Table 10 Questionable Data Register

71

Bit Number Decimal Value Definition
0 SYSClock Status warning 1 One or multiple system clock outputs have been switched off
(to protect themselves).

1 Not used Returns “0”

2 Not used Returns “0”

3 Not used Returns “0”

4 Not used 16 Returns “0”

5 Not used 32 Returns “0”

6 Not used 64 Returns “0”

7 Not used 128 Returns “0”

8 Not used 256 Returns “0”

9 Not used 512 Returns “0”

10 Not used 1024 Returns “0”

11 Not used 2048 Returns “0”

12 Not used 4096 Returns “0”

13 Not used 8192 Returns “0”

14 Not used 16384 Returns “0”

15 Not used 32768 Returns “0”
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The following commands access the questionable status group.

5.6.3.1  :STATus:QUEStionable[:EVENt]?

Reads the event register in the questionable status group. It’s a read-only register.
Once a bit is set, it remains set until cleared by this command or the *CLsS
command. A query of the register returns a decimal value which corresponds to the
binary-weighted sum of all bits set in the register.

5.6.3.2 :STATus:QUEStionable:CONDition?

Reads the condition register in the questionable status group. It’s a read-only
register and bits are not cleared when you read the register. A query of the register
returns a decimal value which corresponds to the binary-weighted sum of all bits set
in the register.

5.6.3.3 :STATus:QUEStionable:ENABIle[?]

Sets or queries the enable register in the questionable status group. The selected
bits are then reported to the Status Byte. A *cLsS will not clear the enable register
but it does clear all bits in the event register. To enable bits in the enable register,
you must write a decimal value which corresponds to the binary-weighted sum of the
bits you wish to enable in the register.

5.6.3.4 :STATus:QUEStionable:NTRansition[?]

72

Sets or queries the negative-transition register in the questionable status group. A
negative transition filter allows an event to be reported when a condition changes
from true to false. Setting both positive/negative filters true allows an event to be
reported anytime the condition changes. Clearing both filters disable event reporting.
The contents of transition filters are unchanged by *cLsS and *RST.
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5.6.3.6  :STATus:QUEStionable:PTRansition[?]
Set or queries the positive-transition register in the questionable status group. A
positive transition filter allows an event to be reported when a condition changes
from false to true. Setting both positive/negative filters true allows an event to be
reported anytime the condition changes. Clearing both filters disable event reporting.
The contents of transition filters are unchanged by *CLS and *RST.
5.6.4  Operation Status Subsystem
The Operation Status register contains conditions which are part of the instrument’s
normal operation.
Table 11 Operation Status Register
Bit Number Decimal Value Definition
0 Not used 1 Returns “0”
1 Not used 2 Returns “0”
2 Not used 4 Returns “0”
3 Not used 8 Returns “0”
4 Not used 16 Returns “0”
5 Not used 32 Returns “0”
6 Not used 64 Returns “0”
7 Not used 128 Returns “0”
8 Run Status 256 Indicates if the multi-module group is in running/armed state
(:INIT:IMM was executed).
9 Not used 512 Returns “0”
10 Notused 1024 Returns “0”
1" Not used 2048 Returns “0”
12 Notused 4096 Returns “0”
13 Notused 8192 Returns “0”
14 Notused 16384 Returns “0”
15 Notused 32768 Returns “0”
The following commands access the operation status group.
5.6.4.1  :STATus:OPERation[:EVENt]?
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Reads the event register in the operation status group. It's a read-only register. Once
a bit is set, it remains set until cleared by this command or *CLS command. A query

of the register returns a decimal value which corresponds to the binary-weighted
sum of all bits set in the register.

73



74 Remote Programming

5.6.4.2

5.6.4.3

5.6.4.4

74

:STATus:OPERation:CONDition?

Reads the condition register in the operation status group. It's a read-only register
and bits are not cleared when you read the register. A query of the register returns a
decimal value which corresponds to the binary-weighted sum of all bits set in the
register.

:STATus:OPERation:ENABLle[?]

Sets or queries the enable register in the operation status group. The selected bits
are then reported to the Status Byte. A *cLs will not clear the enable register but it
does clear all bits in the event register. To enable bits in the enable register, you
must write a decimal value which corresponds to the binary-weighted sum of the bits
you wish to enable in the register.

:STATus:OPERation:NTRansition[?]

Sets or queries the negative-transition register in the operation status group. A
negative transition filter allows an event to be reported when a condition changes
from true to false. Setting both positive/negative filters true allows an event to be
reported anytime the condition changes. Clearing both filters disable event reporting.
The contents of transition filters are unchanged by *CLS and *RST.
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5.6.4.5 :STATus:OPERation:PTRansition[?]

Set or queries the positive-transition register in the operation status group. A positive
transition filter allows an event to be reported when a condition changes from false
to true. Setting both positive/negative filters true allows an event to be reported
anytime the condition changes. Clearing both filters disable event reporting. The
contents of transition filters are unchanged by *cLS and *RST.

5.6.5 Run Status Subsystem

The Run Status register contains the run status conditions of the multi-module
group.

The following SCPI commands and queries are supported:
:STATus:OPERation:RUN[:EVENt]?

:STATus:OPERation:RUN:CONDition?

:STATus:OPERation:RUN:ENABLe[?]

:STATus:OPERation:RUN:NTRansition[?]
:STATus:OPERation:RUN:PTRansition[?]

Table 12 Run Status Register

Bit Number Decimal Value Definition
0 Run Status 1 Indicates if the multi-module group is in running/armed state (:INIT:IMM
was executed).
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5.7 :ARM/TRIGger Subsystem

5.7.1

5.7.2

5.7.3

76

:ABORt
Command :ABOR
Long :ABORt
Parameters None
Parameter Suffix None
Description Stop signal generation on all channels of the multi-module group.
Example Command

:ABOR

:!INITiate:IMMediate

Command :INIT:IMM

Long :INITiate:IMMediate

Parameters None

Parameter Suffix None

Description Set all channels of the multi-module group to an armed state. Signal generation is
started after a trigger is received.

Example Command
:INIT:IMM

:ARM[:SEQuence][:STARt][:LAYer]:-TRIGger:LEVel[?] <level>|MINimum|MAXimum

Command :ARM[:SEQ] [:STAR] [:LAY] : TRIG:LEV[?]

Long :ARM[ : SEQuence] [ : STARt] [:LAYer] :TRIGger:LEVel [?]

Parameters <level>|MINimum|MAXimum

Parameter Suffix Volt (V) or millivolt (mV)

Description Set or query the threshold level of the M8192A trigger input.
<level> — Threshold level voltage.

Example Command

:ARM:TRIG:LEV 3e-9

Query
:ARM:TRIG:LEV?
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5.7.4 :ARM[:SEQuence][:STARt][:LAYer]:TRIGger:IMPedance[?] LOW|HIGH

Command

Long
Parameters
Parameter Suffix
Description

Example

:ARM[:SEQ] [:STAR] [:LAY] : TRIG:IMP[?]

:ARM[ : SEQuence] [ : STARt] [:LAYer] : TRIGger: IMPedance[?]
LOWI|HIGH

None

Set or query the impedance of the M8192A trigger input.

LOW - low impedance (50 Q)

HIGH - high impedance (1 kQ)

Command
:ARM:TRIG:IMP HIGH

Query
:ARM:TRIG:IMP?

5.7.5 :TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate]

Command

Long
Parameters
Parameter Suffix
Description
Example

:TRIG[:SEQ] [:STAR] :BEG[ : IMM]

:TRIGger|[:SEQuence] [:STARt] :BEGin[:IMMediate]

None

None

Send the start/begin event to all channels of the multi-module group.

Command
:TRIG:BEG

5.7.6 :TRIGger[:SEQuence][:STARt]:BEGin:HWDisable[:STATe][?] O|1|OFF|ON

Command

Long
Parameters
Parameter Suffix
Description

Example
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:TRIG[:SEQ] [:STAR] :BEG:HWD[:STAT] [?]
:TRIGger|[:SEQuence] [ :STARt] :BEGin:HWDisable[:STATe] [?]
0[1|OFF|ON

None

Set or query the M8192A’s hardware input disable state for the trigger function.
When the hardware input is disabled, a trigger can only be generated using the
‘TRIGger[:SEQuence][:STARt]:BEGin[:IMMediate] command. When the hardware
input is enabled, a trigger can be generated by command or by a signal present at
the trigger input of the M8192A.

Command

:TRIG:BEG:HWD ON

Query
:TRIG:BEG:HWD?

77



78

5.8

5.8.1

78

Remote Programming

INSTrument Subsystem

:INSTrument:SLOT[:NUMBer]?

Command :INST:SLOT[ :NUMB] ?
Long :INSTrument :SLOT [ : NUMBer] ?
Parameters None
Parameter Suffix None
Description Query the instrument’s slot number in its AXle frame.
Example Query
:INST:SLOT?
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5.8.2 Multi-module configuration commands

These commands and queries are used to identify reachable M8190A modules and to
define a multi-module group consisting of one master module and up to five slave
modules.

5.8.2.1 :INSTrument:MDIScover?

Command

Long
Parameters
Parameter Suffix
Description

Example

:INST:MDIS?
:INSTrument :MDIScover?
None

None

This query returns a comma-separated list of VISA resource strings of all M8190A
modules known by the VISA Resource Manager.

Query
:INST:MDIS?

5.8.2.2 :INSTrument:IDENtify <visa_resource_string>

Command

Long
Parameters
Parameter Suffix
Description

Example

:INST:IDEN
:INSTrument : IDENtify
<visa_resource_string>
None

This command toggles the green “Access” LED of the M8190 module with the passed
VISA resource string for 10 seconds. This allows easy identification of one module in
a setup consisting of multiple AXI frames and multiple modules.

Command

:INST:IDEN “TCPIPO::localhost::hislipO::INSTR”

5.8.2.3 :INSTrument: SLAVe:LIST?

Command

Long
Parameters
Parameter Suffix
Description

Example
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:INST:SLAV:LIST?
:INSTrument :SLAVe:LIST?
None

None

This query returns a comma-separated list of VISA resource strings of all M8190A
slave modules that belong to the multi-module group.

Query
:INST:SLAV:LIST?
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5.8.2.4 :INSTrument:MMODule:CONFigmode[?] 0|1|OFF|ON

Command : INST:MMOD:CONF[?]

Long :INSTrument :MMODule :CONFigmode [?]

Parameters 0|1|OFF|ON

Parameter Suffix None

Description The command form enables (1|ON) or disables (0]JOFF) the multi-module

configuration mode for the complete multi-module group. The command forms of
the following SCPIs for master and slave selection are only available in multi-module
configuration mode. When the multi-module configuration mode is disabled, the
modifications become active.

Furthermore, the commands for setting the clocking parameters on the M8190A
master module (DAC output mode, internal sample frequency, external sample
frequency, sample clock source, reference clock source, and reference frequency) are
only available in multi-module configuration mode.

The query form returns the state of the multi-module configuration mode.

Example Command
: INST:MMOD: CONF ON

Query
: INST :MMOD: CONF'?

5.8.2.5 :INSTrument:SLAVe:ADD < visa_resource_string>

Command : INST:SLAV:ADD

Long : INSTrument : SLAVe : ADD

Parameters < visa_resource_string>

Parameter Suffix None

Description This command adds the M8190A module with the passed VISA resource string as
slave to the multi-module group.

Example Command

:INST:SLAV:ADD “TCPIPO::localhost::hislipO::INSTR”

5.8.2.6 :INSTrument: SLAVe:DELete < visa_resource_string>

Command :INST:SLAV:DEL

Long :INSTrument:SLAVe:DELete

Parameters < visa_resource_string>

Parameter Suffix None

Description This command deletes the M8190A slave module with the passed VISA resource
string from the multi-module group.

Example Command

:INST:SLAV:DEL “TCPIPO::localhost::hislipO::INSTR”
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5.8.2.7 :INSTrument: SLAVe:DELete:ALL

Command

Long
Parameters
Parameter Suffix
Description
Example

:INST:SLAV:DEL:ALL

: INSTrument :SLAVe:DELete:ALL

None

None

This command deletes all M8190A slave modules from the multi-module group.

Command
:INST:SLAV:DEL:ALL

5.8.2.8 :INSTrument:MASTer[?][<visa_resource_string>]

Command

Long
Parameters
Parameter Suffix
Description

Example

:INST:MAST[?]
:INSTrument :MASTer [?]
<visa_resource_string>
None

The command form selects the M8190A module with the passed VISA resource
string as master.

The query form returns the VISA resource string of the M8190A module that is the
master or an empty string, if no master is selected.

Command

:INST:MAST “TCPIPO::localhost::hislipO::INSTR”

Query
:INST:MAST?

5.9 MMEMory Subsystem

MMEM commands requiring <directory_name> assume the current directory if a
relative path or no path is provided. If an absolute path is provided, then it is ignored.

5.9.1 :MMEMory:CATalog? [<directory_name>]

Command

Long
Parameters
Parameter Suffix
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:MMEM:CAT?
:MMEMory:CATalog?
None

None
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Description

Example

Query disk usage information (drive capacity, free space available) and obtain a list of
files and directories in a specified directory in the following format:
<numeric_value>,<numeric_value> {<file_entry>}

This command returns two numeric parameters and as many strings as there are files
and directories. The first parameter indicates the total amount of storage currently
used in bytes. The second parameter indicates the total amount of storage available,
also in bytes. The <file_entry> is a string. Each <file_entry> indicates the name, type,
and size of one file in the directory list:

<file_name>,<file_type>,<file_size>

As the Windows file system has an extension that indicates file type, <file_type> is
always empty. <file_size> provides the size of the file in bytes. In case of directories,
<file_entry> is surrounded by square brackets and both <file_type> and <file_size>
are empty.

Query
:MMEM: CAT?

MMEMory:CDIRectory [<directory_name>]

Command

Long
Parameters
Parameter Suffix
Description

Example

:MMEM:CDIR
:MMEMory:CDIRectory
None

None

Changes the default directory for a mass memory file system. The <directory_name>
parameter is a string. If no parameter is specified, the directory is set to the *RST
value. At *RST, this value is set to the default user data storage area, that is defined
as System.Environment.SpecialFolder.Personal

e.g. C:\Users\Name\Documents

MMEMory :CDIRectory? — Query returns full path of the default directory.

Command
:MMEM:CDIR “C:\Users\Name\Documents”

Query
:MMEM:CDIR?

:MMEMory:COPY <string>,<string>[,<string>,<string>]

Command

Long
Parameters
Parameter Suffix

:MMEM: COPY
:MMEMory:COPY
<string>,<string>
None
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Description Copies an existing file to a new file or an existing directory to a new directory. Two
forms of parameters are allowed. The first form has two parameters. In this form, the
first parameter specifies the source, and the second parameter specifies the
destination.

The second form has four parameters. In this form, the first and third parameters
specify the file names. The second and fourth parameters specify the directories. The
first pair of parameters specifies the source. The second pair specifies the
destination. An error is generated if the source doesn't exist or the destination file
already exists.

Example Command
:MMEM:COPY "C:\data.txt", "C:\data new.txt"

:MMEMory:DELete <file_name>[,<directory_name>]
Command :MMEM: DEL
Long :MMEMory:DELete
Parameters <file_name>
Parameter Suffix None
Description Removes a file from the specified directory. The <file_name> parameter specifies the
file to be removed.
Example Command
:MMEM:DEL "C:\data.txt"
:MMEMory:DATA <file_name>, <data>
Command :MMEM: DATA
Long :MMEMory : DATA
Parameters <file_name>, <data>
Parameter Suffix None
Description The command form is MMEMory : DATA <file_name>,<data>. It loads <data>
into the file <file_name>. <data> is in 488.2 block format. <file_name> is string data.
Example Command
:MMEM:DATA “C:\data.txt”, #l4test
:MMEMory:DATA? <file_name>
Command :MMEM: DATA?
Long :MMEMory : DATA?
Parameters <file_name>
Parameter Suffix None
Description The query form is MMEMory : DATA? <file_ name> with the response being the
associated <data> in block format.
Example Query

:MMEM:DATA? "C:\data.txt"
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:MMEMory:MDIRectory <directory_name>
Command :MMEM:MDIR
Long :MMEMory:MDIRectory
Parameters <directory_name>
Parameter Suffix None
Description Creates a new directory. The <directory_name> parameter specifies the name to be
created.
Example Command

:MMEM:MDIR "C:\data dir"

:MMEMory:MOVE <string>,<string>[,<string>,<string>]
Command :MMEM : MOVE
Long :MMEMory : MOVE
Parameters <string>,<string>[, <string>,<string>]
Parameter Suffix None
Description Moves an existing file to a new file or an existing directory to a new directory. Two

forms of parameters are allowed. The first form has two parameters. In this form, the
first parameter specifies the source, and the second parameter specifies the
destination.

The second form has four parameters. In this form, the first and third parameters
specify the file names. The second and fourth parameters specify the directories. The
first pair of parameters specifies the source. The second pair specifies the
destination. An error is generated if the source doesn't exist or the destination file
already exists.

Example Command
:MMEM:MDIR "C:\data dir","C:\newdata dir"

:MMEMory:RDIRectory <directory_name>

Command :MMEM:RDIR

Long :MMEMory:RDIRectory

Parameters <directory_name >

Parameter Suffix None

Description Removes a directory. The <directory_name> parameter specifies the directory name
to be removed. All files and directories under the specified directory are also
removed.

Example Command

:MMEM:RDIR "C:\newdata dir"
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5.9.10 :MMEMory:LOAD:CSTate <file_name>

Command

Long
Parameters
Parameter Suffix
Description
Example

:MMEM: LOAD:CST

:MMEMory:LOAD:CSTate

<file_name >

None

Current STate of instrument is loaded from a file.

Command
:MMEM:LOAD:CST "C:\data.txt"

5.9.11 :MMEMory:STORe:CSTate <file_name>

Command

Long
Parameters
Parameter Suffix
Description
Example
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:MMEM:STOR:CST
:MMEMory:STORe:CSTate

<file_name >

None

Current STate of instrument is stored to a file.

Command
:MMEM: STOR:CST "C:\data.txt"
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5.10 TEST Subsystem

5.10.1 :TEST:PON?
Command :TEST: PON?
Long :TEST: PON?
Parameters None
Parameter Suffix None

Description
Example

5.10.2 :TEST:TST?

86

Command

Long
Parameters
Parameter Suffix
Description

Example

Return the results of the power on self-tests.

Query
:TEST : PON?

:TEST:TST?

:TEST:TST?

None

None

Same as *T'ST?, but the actual test messages are returned.

Query
:TEST:TST?

m Currently same as : TEST: PON?
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Performance Specification

General

The performance specification can be found in the data sheet available at:
http://www.Keysight.com/find/M8192A

Table 13 Characteristics

Characteristics Description

Power consumption 60 W

Operating temperature 0°Cto40°C

Storage temperature -40°Cto70°C

Operating humidity 5 % to 80 % relative humidity

Operating altitude up to 2000 m

Safety designed to IEC61010-1, UL61010, CSA22.2 61010.1 tested

Interface to controlling PC

PCle (see AXle chassis specification)

Form factor

1-slot AXle module

Dimensions (W x H x D) 351 mmx 29 mm x 310 mm
Weight 3.1kg
Warm-up time 30 minutes

Calibration interval

2 years recommended

Warranty

3 years standard

Cooling
Requirements

When operating the M8192A, choose a location that provides at least 80 mm of clearance at rear, and at
least 30 mm of clearance at each side for the AXle chassis.

WARNING

The instrument is not designed for outdoor use. Do not expose the instrument to rain
or other excessive moisture. Protect the instrument from humidity and temperature
changes, which could cause condensation within the instrument.

Do not operate the instrument in the presence of flammable gases, fumes or
powders. Operation of any electrical instrument in such an environment constitutes a
definite safety hazard.
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6.3 Maintenance
6.3.1 ESD Protection

La
ATTENTION

OBSERVE PRECAUTIONS

DEVICES
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All the connectors are very sensitive to electrostatic discharge (ESD). When you
connect a device or cable that is not fully discharged to these connectors, you risk
damage to the instrument and expensive instrument repairs.

Electrostatic discharge (ESD) can damage the circuits of the M8192A. Avoid applying
static discharges to the front-panel connectors. Before connecting any coaxial cable
to the connectors, momentarily short the center and outer conductors of the cable
together. Avoid touching the front-panel connectors without first touching the frame
of the instrument. Be sure the instrument and all connected devices (DUT, etc.) are
properly earth-grounded (to a common ground) to prevent buildup of static charge
and electrical

over-stress.
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6.3.2 Power and Ventilation Requirements

For power and ventilation requirements, refer to:
o http://www.Keysight.com/find/M9505A for 5-slot chassis related
documentation.

o http://www.Keysight.com/find/M9502A for 2-slot chassis related
documentation.

6.3.3 Thermal Protection

Overheating Detection  The instrument monitors its internal temperature. If the temperature exceeds
approximately 80 °C the power supply is switched off. The instrument will not turn on
automatically if the temperature is decreasing again.

Fan Failure If a fan is broken or prevented from operating by a blockage the temperature will
increase. When the temperature exceeds approximately 80 °C the overheating
detection switches off the instrument for safety reasons. For reliability it is
recommended to send instruments with broken or defective fans immediately to
Keysight Service for repair.

6.3.4 Cleaning Recommendation

WARNING To prevent electrical shock, disconnect the instrument from mains before cleaning.

Use a dry cloth or one slightly dampened with water to clean external case parts. Do
not attempt to clean internally.
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